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PREFACE

Information is Knowledge ; Knowledge is Power

This textbook on INFORMATION COMMUNICATION TECHNOLOGY

for X Standard Matriculation is prepared as per the new guidelines and syllabi

prescribed by the Directorate of Matriculation Schools, Government of Tamilnadu.

Bringing technology to education is a slow, but steady revolution. To match

the growing technological changes, we are in the race to keep our young generation

abreast in this globalized epoch.

This era is an information era. Just by clicking, we can go around the globe

and hunt the know-hows of anything from anywhere and at anytime. Exchanging

information is the key process of the world wide web sites and it is left to the

browsers to use them effectively for their information needs. Only effective users

can use the available innovative inventions successfully. Hence, to make the learners

familiar with the various technological developments, we have to provide them

adequate knowledge.

Keeping this in view, the syllabi include the concepts of DATA BASES II,

VISUAL BASIC and IT APPLICATIONS. Special care has been taken to clearly

explain the technical usage of the concepts.

The special feature of the book is that it helps to visualize the theoretical

concepts. It is hoped that this will create awareness on the basic principles of

Information Technology and enthuse the learners to acquire more information.

We wish the students to enjoy this informative subject and become masters

in Information Communication Technology.

Learned suggestions and constructive criticisms for the effective refinement

of the book will be appreciated.

Computers are becoming smarter;
Use them to become the smartest master.

Swaminathan .R
Chairperson
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1. DATA BASES II

1.1. INTRODUCTION

Computers are applied in almost every field.  Initially computers were
used to solve complicated scientific and mathematical problems. But today,
they are mostly used to process huge data. That is why, computers are called
‘Information Processing Systems’.  They accept raw data as input and process
them to produce a meaningful information.

You have learnt in the earlier standards about the basic concepts on
data structures and data processing. You have also learnt to use Microsoft
Access - a Database Management System (DBMS) software to create
and use databases.  Microsoft Access is a database program that enables to
create databases and enter, store, analyse and present data. Access provides
easy-to-use, powerful tools to manage database related applications.

The term database refers to a collection of related information such as
details of students in a school, marks obtained by them in the various
examinations, accounting details of a company, etc.

The primary object in a database for collecting and storing data is
called a Table as shown in fig.1.1. Tables are organised into rows and columns
similar to an Electronic spreadsheet you have learnt in your lower classes.

Fig. 1.1
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An individual entry in a table (for example, a student’s admission no., name
and marks) is called a record and is stored as a horizontal row. Each record
in a table  consists of one or more fields. A field holds a single piece of data.
So, each table column represents a field, which groups data among the records
into specific categories or types of data. You have already learnt in your
Ninth standard how to create database tables using Access. Now, we will
learn about the various database operations using Access.

1.2 DATABASE OPERATIONS

Maintaining a database is a very important task in managing databases.
It is also a difficult work to do. Updating the contents of a table by adding
and deleting records and correcting mistakes can take considerable amount
of time. But, Access provides some tools and methods that can help to
manipulate data and carryout the various tasks related to data maintenance
and management.

1.2.1. Editing Databases

Editing database means modifying the table structures and editing the
data. Editing data may include changing the value of a field in a record,
deleting a record or appending a record. Appending a record means adding
a record to the end of the table.

Table Views

There are two views to choose from, when making changes to a table
in the database.

(i) Design View : This view is used for making changes to the
database structure. For example, adding a field  or changing a
field name. We can also delete a field or change its properties.
Last year you would have used this view to set up the database
structure for the tables you had created. To select the Design

View, click the   icon from the Table Data sheet toolbar or

right click the table name and select Design View option.

(ii) Data Sheet View: This view is used for entering and editing the
data in the database. To open the Data Sheet View, double click
the table.
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Editing and Deleting data in a Table

Editing may include changing a value of a field in a record. We can
change the contents of any field by clicking in the field and editing in the
usual way. We can use the Backspace or the Delete key to delete the unwanted
data or make any corrections.  We can undo the changes using the Undo

icon .

Using Record Selectors and Finding a record

We can simply click the required row to go to that record.  But real
databases usually have hundreds of  records. So, we can move to the required
record or to the first or the last record using the record selectors in the Data
Sheet View (Fig. 1.2)

Fig. 1.2

Sometimes we may want to find the record of a particular value. This is very
useful in case of larger databases. Suppose we want to find the record of
Elma in the table created using the data in fig. 1.1., We can do so using the

Find option from the Edit menu by clicking the Find icon .

Click the Find icon from the toolbar

Type the name Elma in the Find and Replace dialog box that appears.

Fig. 1.3
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Select ‘Halfy marks’ the name of the table in Look  In combo  box and
click Find Next. The record containing the word ‘Elma’ is highlighted.

Fig. 1.4

Adding a new record

Suppose a new student has joined the class, then the database table
needs to be upgraded by adding a new record. It is easy to add a new record
to the existing database table using Access.

There are two ways to add a new record to a database table:

1. Just click in the next blank line in the table and enter the new
values.

2. Press the New Record icon , either on the record selector or
on the Menu bar.
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Deleting a record

To delete a record , click anywhere in the record and press the Delete

icon   on the toolbar. The following message box appears:

Fig. 1.5

Click 'Yes' to delete the record. After  completing the required
modifications, Save and Close your database table.

1.2.2 Modifying a Table Structure

A database is a dynamic entity. The table which is the main object of
the database has to be changed based on the needs and changes that take
place in the organization which uses the database.  Apart from changing the
data contained in the table, the structure of the table itself had to be changed
sometimes.

Access enables  us  to modify a table’s structure quickly and efficiently.
We can add, delete and change field specifications in Table Design View
similar to editing a data in a datasheet.  But  changes in table's structure
should be carried out carefully as it will affect the forms and reports that are
based on the table.

Inserting and Deleting Fields

After displaying a table structure in Design View, we can easily add or
remove fields.

To insert a field in Table Design View;

1. Select an empty row in the Field Grid pane.
2. Type a field name, select the required data type, enter a

description and set the properties.
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3. To insert a field in between, select the row where the field has to

be inserted and click  Insert Row icon ,

To delete a field in Table Design View;

1. Right Click at the row selector of the field that has to be deleted.

2. Click the Delete Row icon  .

Alternatively, we can also insert and delete fields using the Insert
Rows option under the Insert Menu and Delete Rows option under the Edit
Menu.

Renaming and Moving Fields

In addition to modifying a table’s structure, we can also rename or
move a field to another location in a table using the Table Design View.

To rename a field, edit the contents or type a new name in the Field
Name column just as modifying a cell entry.

To  move a field, click the field’s row selector button, hold and drag it
to the desired location.

1.3. SORTING

Records are displayed in the order that they are originally entered into
the table. We can rearrange the records in a table using Access. Access
allows to rearrange the records in a data sheet by the contents of any field
into

1. Ascending order (0 to 9; A to Z)

2. Descending order ( Z to A; 9 to 0)

Sorting is one of the methods of extracting information from raw data.
It helps to organize the records in a better manner and scan through a
datasheet for specific information.

To sort the records of a table;

1. Open the table that has to be sorted.
2. Select the field to be sorted by clicking the field name at

the top of the table. Now, the entire column gets high-
lighted.
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3. Click the Sort Ascending order icon. . The records

in the table are displayed in the ascending order of the
selected field.

4. To sort the records in the descending order, select the

field and click the Sort Descending  order icon. 

For example, if we select the field ‘name’ and click the Sort Ascending
icon, the data in the table ‘halfy marks’ is sorted on the 'name' field in
alphabetical order and the table looks as shown below in fig. 1.6.

Fig. 1.6

1.4. USING FILTERS

Filter is a type of query. It is used to select and display records that
match a certain condition. The records that do not match the condition given
in the criteria clause are hidden from the user. The difference between query
and filters is that queries can be saved for later use but the filters are not.
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There are several methods available in Access for filtering records in a
table. They are

1. Filter For Input
2. Filter By Selection
3. Filter Excluding Selection
4. Filtering By Form
5. Advanced Filter/Sort Option
6. Remove Filter Option

Let us learn how to use these Filter methods to display only the required
records that match a criteria in a table.

1.4.1. Filter For Input
The Filter For Input method helps to specify which records are to be

displayed.

To apply this filter
1. Right Click at a field entry
2. Type a value or a condition for value into the Filter For: text box

Fig. 1.7
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For example, right click at English field and type > 80 in the Filter
For: text box. Only those records which have the value > 80  in the English
field are displayed. The table appears as shown in fig. 1.8 after applying the
filter.

Fig. 1.8

1.4.2. Filter By Selection
Using Filter By Selection Method, we can apply a filter; based on a

selected value from a data sheet. The selection may be a cell’s content or
only a portion of the content.

To apply Filter By Selection;
1. Select all or part of the field entry

2. Click on the Filter By Selection button 

or  Select  Records à Filter à Filter By Selection

Fig. 1.9
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For example, to view only the records which have the mark 90 in
Geography, place the cursor at the cell which has 90 in the Geography field
and click Field By Selection icon. The table looks as shown in fig. 1.10
below:

Fig. 1.10

1.4.3. Filter Excluding Selection
Filter Excluding Selection option is used to display only those records

that do not match the selected value. To apply Filter Excluding Selection;
1. Select  all or part of the field entry
2. Select Records à Filter à Filter Excluding Selection.
If the Filter Excluding Selection is applied to the case where the mark

is  90 in the Geography field, then the table display will be as shown in
fig.1.11. Only those records that do not have the value 90 in Geography
field are displayed.

Fig. 1.11
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1.4.4. Filtering By Form

If more detailed filtering is needed, then Filter By Form option method
can be used. When we use Filter By Form method, a blank data sheet row
appears to enter the desired criteria. Once we have defined the filter criteria,
Access enables us to save it as a query object in the Database Window.

To apply Filter By Form :

1. Click Filter By Form button 

or  Select Records → Filter  → Filter By Form
2. Enter the required filtering criteria.

3. Click Apply/Remove Filter button  to save Filter

By Form as a query for later use.

1.4.5. Advanced Filter/Sort Option

This is an Advanced Filter Option in which we can specify a more
complex multiple criteria for applying the filter.

To apply an Advanced Filter/Sort option:

1. Open the table to be used. In this case open Halfy marks

2. Select Records → Filter  → Advanced Filter /Sort

Fig. 1.12
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The following Filter screen appears where in we can set the various
criteria for filtering.

Fig. 1.13

Let us set the criteria that only those records that have English marks
> 70 and Maths marks > 80 should be filtered and displayed.

To carry out this filtering;

1. Drag the English field using the mouse and put it in the first field
column.

2. Set the criteria under the Criteria as English marks > 70

3. Drag the Maths field using the mouse and put it in the second
field column.

4. Set the Criteria as Maths marks > 80

Fig.  1.14
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Now, click the Apply Filter icon . Access filters only those records

which have the  value under English field > 70 and Maths field > 80. The
following screen appears.

Fig. 1.15

Filtering is a sort of query where answers to certain questions are

obtained. It displays those records satisfying the condition that is set in the

criteria clause. But the results of filters are not stored for future use. We can

use more operators to set multiple and complex criteria under Queries.

1.4.6. Remove Filter Option

The original table can be restored back using the Remove Filter Option.

To remove the filter, click the Remove Filter icon .

1.5. CREATING A QUERY

The basic purpose of creating a database is to retrieve the required

information at a later date. To get the required information, we have to ask

certain questions to Access. These questions framed in a special manner are

called Queries. Queries are special views of the data in a table. Unlike sort,

the output from a query does not affect the original table. The results from

a query is always stored separately and can be viewed at anytime.

One of the most useful things  we  can do with a database is to find all

the records that satisfy a certain condition like “All the students who have

scored above 90 in Mathematics”. We can do this in a very simple manner

using the Queries option in Access. This is called querying the database.
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1.5.1. Creating a new Query
To create a new  query;

1. Open the Database Window.

2. Click on the Queries option from the Object Bar.

The window as shown in fig. 1.16 will appear.

 Fig. 1.16

There are two options available for creating a query under this window

as displayed on the right Pane.

1. Create query in Design View

2. Create query by using Wizard.

Creating a Query in Design View

To create a query in Design View :

1. Double click 'Create query in Design View' option in the right

pane of the database window.



15

The following window will appear.

Fig. 1.17

The Show Table dialog box that is displayed in the query window, lists
all the tables that are stored under the selected database. Select the tables to
be included in the query by double clicking them and then click the Close
button. Let us select only the table ‘Halfy marks’ to  learn how to use query
in Access. The selected table will be displayed above the design grid as
shown in fig. 1.18.

Fig. 1.18
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Any one of the three methods given below can be used  to add  fields
into the query.

• Drag the field name from the selected table list and drop it in the
field column of the grid.

• Double click the field name from  the selected table list and it will
be automatically added to the field column of the grid

• Select the field name from the drop down list displayed in the
field column and click it.

Once  the required fields are added into the query,

• The Field row displays all the selected fields.

• The Table row displays the respective Table names from which
the fields are selected. In this case it will display the table name
‘Halfy marks’.

• The Show field contains a check box. Using this the user can
either show or hide a particular field when the query is displayed.
By default the check box is in the selected state. To deselect it,
click on the checkbox once again and the field becomes  hidden.

• The Criteria field is used to set the conditions for the values of
the fields to be displayed when the query is executed. As you
have learnt under Filters, these conditions will filter the records
and display only those records which satisfy all the conditions as
set in the query.

Let us set the criteria to display only the fields Adm No, Name, Maths
and Science marks from  the table ‘Halfy marks’ for those records which
have  Maths field value >=80 and Science field value >=70. After setting the
criteria,  the screen will appear as shown in fig. 1.19  below;
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Fig. 1.19

The  query is complete now. Just click the Run icon  on the toolbar

to display the result of the query. The screen as shown in fig.1.20 appears
displaying only those records which have  Maths field value >=80 and Science
field value >=70.

Fig. 1.20

Saving the Query

To save the query for later use;

• Open the File menu and select the Save option

• In the Save As dialog box, type a name for your query and click
the OK button.
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The query window  can be closed by clicking the Close option from
the File menu.

Creating a Query by Using Wizard

Queries can be created in Access using wizards. The wizards guide to
create the required query easily. There are four wizards available in Access.

To create a query using wizards,

• Double click 'Create query by using wizard' option from the right
pane of the Database window to start creating a simple query or

• Select Queries from the objects option and click New option

 from the Standard Toolbar.

• The New Query dialog box displays  five options to create a
Query including ‘Design View’ option, which you have learnt
already.

Fig. 1.21
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The following are the four wizards used to create a query.

1. Simple Query Wizard

2. Crosstab Query Wizard

3. Find Duplicates  Query Wizard

4. Find Unmatched Query Wizard

We will learn to use Simple Query Wizard to create a query.

Simple Query Wizard

When Simple Query Wizard  is selected, the wizard screen will appear
as shown in fig. 1.22

Fig. 1.22

• Select the table name from the Tables/Queries list box for which
a query has to be created .

• Select the fields for the query from the left pane ‘Available Fields’.
Use Select button to select a single field and Select All button to
select all the fields.
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• The selected fields get included in the right pane ‘Selected Fields’.

• Use Remove or Remove All button to deselect  fields from the
right pane if not required.

After selecting and including the fields in the ‘Selected Fields’ pane,
click Next button.

The next window as shown in fig. 1.23 appears.

Fig. 1.23

Click Next button to continue.

The next window as shown in fig. 1.24 appears.
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Fig. 1.24

Enter the title for the query in the text box and click Finish. The created
query is displayed as shown in fig. 1.25.

Fig. 1.25
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1.6. FORMS

Data can be entered into a database table using the Data Sheet View.
But, when the number of fields in a record are very large in number, then it
becomes very difficult to enter the data. This is due to the fact that in Data
Sheet View only the fields that fit into a page are displayed. An alternative
to working with numerous records in a datasheet is to focus on a single
record at a time using a form. Forms are user interfaces. They allow database
users to type data into a database using a specially designed form, rather
than straightly into a table. Using forms, apart from entering data, we can
also display data after formatting them, change or delete data and also print
forms. We can also create visual effects by adding colours, shades, lines,
boxes, etc, to the fields in the form.

In Access, we can create form in two ways;

1. Using Create Form in Design View option under Forms in the
Database window;  or

2. Using Create Form by using Wizard.

We will learn how to create a Form using the option ‘Create Form by
using Wizard’

1.6.1.Creating Forms Using Wizard

MS Access provides a built-in wizard to design forms. The wizard
takes us through a step-by-step process towards designing and completing
the form. At each stage we have to enter some input to proceed to the next
step.

To create a form using the Form Wizard;

• Select the Forms object in the database window  and then double
click 'Create Form by using Wizard' option.

• The Form Wizard window is displayed as shown in fig. 1.26
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Fig. 1.26

This window helps  to select and include the fields that will appear in
the form. Select the field names in the Available Fields pane and click the
Add button  to add the field to the Selected Fields pane. Click the Add
All button  to add all the fields. If you want to remove a field from the
Selected Fields pane, we can do so by using the appropriate buttons as
shown in fig 1.27 below;

Fig. 1.27
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After selecting and including the required fields, click the Next> option.
The Form Wizard displays the next window as shown in fig. 1.28

Fig. 1.28

Use the above window to choose the layout of the form from the four
options that are displayed as below;

1. Columnar

2. Tabular

3. Datasheet

4. Justified

We can preview each option by clicking it. After selecting the desired
layout, click the Next> button. The Form Wizard displays the next window
as shown in fig. 1.29
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Fig. 1.29

The above window displays the various styles that can be applied to
the form. We can preview each style by clicking at each style name. Select
the style suitable to the form and click Next> button. The Form Wizard
displays the next window as shown in fig.1.30

Fig. 1.30
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The above allows to give a title for  the form. Type the title to the form
in the box provided. This window also provides the choice whether to open
the form or to modify the form’s design. Select your choice. By default, the
first choice is selected. To create the form, click Finish. The created form is
displayed as shown in fig. 1.31

Fig. 1.31

1.6.2. Saving Forms

We can save the form using the Save option from the File menu. In
the Save As dialog box, type a name for the form and click the OK button.

1.7.  REPORT GENERATION

A report is used to present the information retrieved from databases
in a clear and orderly manner so that it is useful and appealing to the user.

Reports created can be viewed on the screen or can be printed to have a
hard copy. Reports can be based on queries or on tables. To attract the
attention of the users, each report may contain a variety of design elements
like fonts, borders, lines, colours, graphics, etc. These elements enhance the
presentation of the information.

Since a report is meant to be printed, Access displays the report in the

Print Preview Window in which we  cannot edit the data displayed in reports.
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1.7.1. Creating Reports using Report Wizard

Access provides a built-in wizard to assist in creating reports. We can

create a report based on the options and styles provided by the wizard.

To create a report using the Report Wizard;

• In the database window, click Reports.

Fig. 1.32

• Double click the ‘Create Report By Using Wizard’ option.

The  Report Wizard window as shown in fig. 1.33 appears.
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Fig. 1.33

This window helps to select and include the fields that will appear in

the report. We have already learnt to use this window to select and include

the fields required into the form.

• After selecting and including the required fields, click Next>

button.

The next window as shown in fig. 1.34 appears.
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Fig. 1.34

This window helps to group the records according to a specified field.

Grouping means all the records having the same value for that field will be

grouped.

• Click the Next> button to continue. The window as shown in

fig. 1.35 appears.
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Fig. 1.35

In the above window, we can sort records by up to four fields, in

either ascending or descending order. Let us sort the records using the Adm

No field in ascending order.

• Select the field to be sorted (i.e., Adm No).

• Select the sort order and click Next > button.

The next window as shown in fig.1.36 appears.
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Fig .1.36

In the above window we can select the Layout of the report and the

page orientation. There are three layouts - Columnar, Tabular and Justified.

Clicking any of the layout option displays a preview of the report in that

particular format. The orientation can be in portrait or landscape format.

Let us select Tabular and Portrait in our case.

• Select the Layout and Orientation and  click Next> button.

The next window as shown in fig.1.37  appears.
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Fig. 1.37

In the above window, select the style to apply for the report from the

choices that are displayed. Clicking at a style displays the preview of the

style selected.

• Select the preferred style and click Next> button.

The next window as shown in fig.1.38 appears.
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Fig.1.38

The above allows to give a title for  the Report. Type the title of the
Report in the box provided. This window also provides the choice whether
to Preview the report or to modify the report’s design. Select your choice.
By default, the first choice is selected. To preview the report, click Finish.
The created report is displayed as shown in fig.1.39 below;

Fig. 1.39
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1.7.2. Saving Reports

We can save the report using the Save option from the File menu. In
the Save As dialog box, type a name for the  report and click the OK button.

1.7.3. Printing Reports

We can print the report using the Print  option from the File menu.
Select the Print option and enter the pages to be printed and number of
copies in the Print dialog box that appears and click OK  button to start the
print process.

1.8. E-DISTRIBUTION OF RECORDS

Information stored on one computer can be shared with the other
computers anywhere in the world provided they are connected to a network.
What is going on in the Internet is sharing of information worldwide.
Similarly, the information stored in databases in the form of tables and records
can be used by the Database Management System of the local area network-
intranet  or internet. Such data sharing and e-distribution of records are
carried out in most on-line processes like Railway Reservation System, Airline
Ticketing, etc.

SELF EVALUATION

I. FILL IN THE BLANKS:

1. Computers are called  ________   __________ Systems.

2. The primary object in a database for collecting and storing data is called a
______.

3. An individual entry in a table  is called a  ______________.

4. There are _________ views to choose from when making changes to a table in
the database.

5. We can undo the changes using the ______ icon.

6. We can move to the required records or to the first or the last record using the
______ in the Data Sheet View.

7. We can add, delete and change field specifications in ________ View.

8. A filter is a type of_____________.
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9. The __________________option is used to display only those records that do
not match the selected value.

10. We can use any one of the _______ methods to add fields into the query.

11. There are _______ wizards available in Access to create a Query.

12. In Access, we can create form in ____ ways

13. We can choose the layout of a form from the _____  options that are displayed
while creating forms using wizard.

14. Access displays the report in the __________ Window.

15. Grouping means all the records having the _____ value for that field will be
grouped.

II. ANSWER IN ONE OR TWO SENTENCES:

1. Expand DBMS.

2. What does the term database refer to?

3. What do you mean by editing a database?

4. Name the two Table Views available in MS Access.

5. How will you add a new record to your table?

6. How will you delete a record in your table?

7. How can you rename a field in a table?

8. Give the two orders in which the records of a table can be sorted.

9. What is a Filter?

10. What are the methods available in Access for filtering records in a table?

11. How will you apply Filter By Selection?

12. What option is used to specify more complex multiple criteria for applying the
filter?

13. How can you remove the filter option you have just applied?

14. What is a query in MS Access?

15. What are the two ways in which you can create a new query?

16. Give the methods to add fields into the query.

17. How will you save a query in MS Access?
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18. Name the wizards used to create a Query.

19. What are the two ways you can create a Form in Access?

20. What is a report?

21. What is e-distribution?

III. ANSWER IN DETAIL:

1. Explain the structure of a table in a database file.

2. Explain the various Table Views in Access.

3. Explain how can we easily add or remove fields while modifying the structure
of  a table.

4. Explain the steps involved in sorting the records of a table.

5. Explain the process of creating a query in Design View.

6. Explain the steps involved in creating a query using Simple Query Wizard.

7. Give the procedure to save and print a report.

DO IT NOW EXERCISES.

1. Create a database file and Table design for the following fields.

1. Employee No 2.  Employee Name 3. Designation

2. Modify the Table structure you have created in Question 1 by adding a new
field Salary.

3. Create a Table with the following data :

Employee No Employee Name Designation Salary

1001 Sekaran PGT 9000

1002 Babu TGT 8400

1003 Lawrence SGT 6700

1004 Rajendra Prasad TGT 7850

1005 Narayanan Assistant 6400

1006 Packkiaraj Typist 5350

1007 Kuppusamy Typist 4850
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4. Create a Table with the following data.  Sort the records using the Name field
in alphabetical order.

Name Mathematics Science Geography

Kavitha 96 89 94

Shankar 67 45 65

Tony 56 34 45

Ravi 78 87 80

Ruby 12 32 24

Sheela 78 89 90

Hendry 100 98 97

Benny 34 32 37

Geetha 56 58 49

Anto 78 65 81

5. Use the table you have created in Question 4 and apply the Filter option in
Access to filter only those records which have the value > 75 in Mathematics
and the value > 60 in Science.

6. Use the table you have created in Question 4 and create a query using the
Design View to display only the details of students who have obtained marks
>=35 in all subjects. Save the result of your query for later use.

7. Using MS Access Report generation option, create a report for the table in
Question 4 to include only the details of students who have obtained marks
>=35 in all subjects. Give the title ‘Promotion List’ for your report.

_________
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2. VISUAL BASIC

2.1.  INTRODUCTION

Visual Basic is the most suitable programming language for developing
programs / applications with Microsoft Windows. The popularity of VB is
because it is equipped with GUI - Graphical User Interface. VB has got a
unique  environment and possesses various components using which varieties
of applications can be created. The VB environment is  known as IDE which
helps in developing every application with the appropriate associated code.
The VB IDE ( Integrated Development Environment ) is helpful to the user
to develop, execute, test and edit / debug the applications.

2.2. INTEGRATED DEVELOPMENT ENVIRONMENT (IDE)
       WINDOWS

The Visual Basic Environment includes the following :

o  New Project Window

o  Toolbox

o  Toolbar

o  Form Window

o  Form Layout Window

o  Project Window

o  Properties Window

New Project Window
When we first start or select a file in VISUAL BASIC, the NEW

PROJECT WINDOW will appear. Project Window is used to manage the
components of application. Any Window’s program is called an application
and consists of a lot of files and before the compilation the number of files
becomes more in number. The Project Window helps to manage all the
components and brings in the component, which the user requires to work
or perform in the editing area.  The New Project Dialog Box will appear in
the screen.
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NEW PROJECT DIALOG BOX

Fig.2.1

Toolbox

The Tool Box Window typically called
the toolbox is a collection of tools which acts
as a repository of controls that can be placed
on a form. Toolbox contains a set of tools that
are used to place controls on a form at design
time. The description of the tool will appear
when the mouse is placed over the icons or
buttons. The various controls in VB toolbox
can be placed on the form by double clicking
the icon in the toolbox. The typical Visual
Basic tool box will appear as in fig 2.2.

Fig.2.2
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TOOL BOX ICONS AND THEIR PURPOSE

ICON PURPOSE ICON PURPOSE

POINTER PICTURE BOX

LABEL TEXT BOX

FRAME COMMAND BUTTON

CHECK BOX OPTION BUTTON

COMBO BOX LIST BOX

HORIZONTAL VERTICAL SCROLL

SCROLL BAR BAR

TIMER DRIVE LIST BOX

DIRECTORY LIST BOX FILE LIST BOX

SHAPE LINE

IMAGE DATA

OLE

Toolbar

The Visual Basic toolbar, which appears in the next line of Menu Bar,
changes frequently during the process of working. Toolbars contain toolbar
buttons, which provide quick access to the most frequently used commands
in an application.
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VB has FOUR different types of toolbars. They are

(i) Debug Toolbar (ii) Editing Toolbar

(iii) Form  Editor (iv) Standard Toolbar

v Debug toolbar contains toolbar buttons for some commonly used
menu items for debugging code. Debug Toolbar helps in correcting
and tracing out the errors with the debugging tools.

v Edit toolbar  contains toolbar buttons for some commonly used
menu items for editing code. Editing Toolbar helps in editing the
Visual Basic Code.

v Form Editor contains toolbar buttons for some commonly used
menu items useful for working with forms. Form Editor helps to
adjust objects on forms.

v Standard toolbar contains toolbar buttons for some commonly
used menu items. It is a default toolbar, which appears below the
Menu Bar.

WINDOWS

The components of  the user interface are placed on a screen, which is
in turn called as WINDOWS. The windows can be maximized or minimized.
The different types of windows available in VB are

(i) Form Window

(ii) Form Layout Window

(iii) Properties Window

(iv) Project Explorer Window.

Form Window

Form Window plays the most vital role in designing VB applications
because the maximum work takes place inside this window. All applications
are designed in the Form Window. Form Window can be adjusted or resized
depending on the application’s need. A Form Window can be activated by
clicking anywhere within the window or on the title bar. The Form Window
allows the user to create controls in the application. The form size can be
maximized  or minimized. The form will have the same features at design
time and at run time, unless the form properties are changed using codes.
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FORM WINDOW

Fig 2.3

Form Layout Window

The Form Layout Window shows the preview of the Form Window’s
location. Form Layout Window allows the user to position the forms at the
design time. All the forms visible in the environment are displayed in the
Form Layout Window. The Form Layout Window will appear as given below
in the screen.

FORM LAYOUT WINDOW

Fig 2.4
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Properties Window

The user can place any number of controls on the form. Once the user

adds controls to a form, he can select them by clicking for changing its

property. The Property Window changes to list every property related to

that control. VB sets the control's initial property values. But the user can

modify  these values. Properties Window displays the design time properties

for selected objects and their current settings. The user can change the

properties during design time.

PROPERTIES WINDOW

Fig 2.5

Project Explorer Window

Project Explorer Window displays a list of the forms, classes , standard
modules and resource files in the application project. Related items are listed
together in a tree listing. This Window has three buttons namely;
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(i) View Object Button - enables to display the object.

(ii) View Code Button - enables to display the code.

(iii) Toggle Folders Button - enables to toggle the folders setting to
      group or ungroup the related objects.

Project Explorer Window

Fig 2.6

THE CONTENT OF A PROJECT

A project holds all the elements of an application; the form window,

the components and the coding. Each standard EXE project must have

atleast one form window. Whenever a standard EXE is created, a blank

project named Project1 will be automatically created.  The contents of a

project include

(i) Form modules

(ii) Class modules

Toggle
Folders
Button

↓
View Code

Button

↓

View Object
Button↓
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(iii) Standard modules

(iv) Resource files.

The sample project window with Tool Box, Form Window, Properties

Window, Form Layout Window will appear as given below in the screen;

SAMPLE PROJECT WINDOW

Fig 2.7

Form Modules

A Form consists of different controls  and menus. The properties of
the controls can be changed on the forms. The codes for the objects are also
present in the form itself. Forms are stored with an extension .FRM

Class Modules

Class modules are used to create our own custom objects. The
subroutines and function procedures defined in a class module become
methods of the custom object. The title bar for a class module always includes
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the label class module. Each form and report in a database can contain an
associated module or report module. These modules are saved with an
extension .CLS

Standard Modules

Standard Modules contain procedures and declarations commonly
accessed by other modules within the application. A standard module can be
reused in different applications. The module has the file extension as .BAS

Resource Files
Resource Files contain references to bitmaps, images and special texts.

These files are saved with an extension .RES.  These files enable the user to
change the data without recompiling the application.

APPLICATION
An application is a collection of forms, controls and  codes that work

together as a single program. Applications are used  to perform a specific
task very easily.  In VB, the user can create application with less amount of
program coding. A new application contains different modules  and forms
organized under a single project.

Running the Project
VB project can be executed in THREE different ways. They are
(a) Press F5 for running the project
(b) Click 'START' from the Run menu

(c) Click 'START' button from the Standard toolbar.

The screen will appear as given below when the user wants to execute
a project by selecting the “Run” option from the Menu Bar.

Fig 2.8
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2.3 DATA TYPES

In programming, one needs to process different types of data. For
example, we may work with numeric type of data, names of persons / places,
some data manipulation, queries, etc. Visual Basic supports the following
different data types.

Data type Storage Range

Byte 1 Byte 0 to 255

Integer 2 Bytes Integer −32,768 to 32768

Long 4 Bytes Integer 2,147,483,648  to
− 2,147,483,648

Single 4 Bytes floating 3.402823E38 to
    point number –3.402823E38

Double 8 Bytes floating 1.79769313486232D308 to
−1.79769313486232D308

Currency 8 Bytes number 922,337,203,685,477.5808 to
with fixed decimal − 922,337,203,685,477.5808

String (fixed length) Length of String 1 to about 65,500 characters

String (Variable) Length + 10 Bytes 0 to 2 billion characters

Date 8 Bytes January 1, 100 to
December 31, 9999

Boolean 2 Bytes True or False

Object 4 Bytes Any embedded object

Variant (Numeric) 16 Bytes Any value as large as
Double

Variant (text) Length plus 22 Same as variable length
Bytes String
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Visual Basic’s Operators

Operator Meaning Example Result

^ Exponentiation 2 ^ 3 8

* Multiplication 2 * 3 6

/ Division 6 / 2 3

+ Addition 2 + 3 5

- Subtraction 6 - 3 3

Mod Modulus 11 mod 3 2

+ or & String Concatenation “Hi” & “Welcome” “Hi Welcome”

Hierarchy of Operators

Order Operators Symbol

1 Parenthesis ( )
2 Exponentiation ^
3 Multiplication, Division, Modulus * / Mod
4 Addition, Subtraction + -

2.4.CONTROL STRUCTURES :

Normally, statements in a program are executed one after another in a
sequential order in which they are written.  However, various VB
statements enable the programmer to specify whether the next statement
has to be executed or not based on certain conditions. For the purpose,
control structures are used in program code.

Control structures are those which control the different sections of
the program code based on specified conditions   That is, the program code
is executed conditionally.  If the specified condition is satisfied, the code will
be executed. If the specified condition is not satisfied, then that section of
the program code will not be executed.

There are many control structures in VB. We shall study about the
following control structures;
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(i)  If ... Then  .... End If  Statements :
In this type of control structure, we can have single line or multiple line

statements between If..Then  and  End If.  This is shown in the following
syntax ;

If  Condition  Then
   statement 1

   statement 2

End If
The following examples illustrate the use of this structure.

Example 1:

If intMark >35 Then
    MsgBox  " YOU HAVE PASSED"

End If
Example 2:

If intTotalpercent  > 60 Then
     MsgBox " CONGRATULATIONS !"

     MsgBox " YOU HAVE PASSED IN FIRST CLASS "

End If

(ii)  Using Else and ElseIf Statement :

Though the If statement is very powerful,  it can test only one condition
at a time.  To check multiple conditions, Else and ElseIf statement is used in
the program code.  This is shown in the following syntax;

If Condition  Then
Statement

ElseIf  Next Condtion   Then
Next Statement

Else
Default Statement

End If
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 Here, If   statement checks the first condition.  If it is true, the related
code in the Then statement is executed and the remaining If  code is skipped.
If it is not true, its related code block is skipped and the first  ElseIf condi-
tion is checked. This process continues until either a condition is true or the
Else statement block is executed.

Example 1 :

To check whether the number typed by the user is Positive or Negative
or Zero, this control structure can be used as follows;

If  intVar1 > 0  Then

MsgBox  " The Number is a Positive Number"

    ElseIf  intVar1 < 0 Then

MsgBox  "The Number is a Negative Number"

    Else

Msg Box  "The Number is equal to Zero"

End If

Example 2:

If  intmedcode = 01 Then

MsgBox " THE MEDIUM IS TAMIL"

       ElseIf  intmedcode = 02 Then

MsgBox " THE MEDIUM IS ENGLISH "

       Else

MsgBox " INCORRECT MEDIUM CODE "

    End If

2.5. VARIOUS CONTROLS IN VISUAL BASIC

2.5.1. TEXT BOX
Text boxes are used when the user wants to type some information like,

an answer to a prompt or to enter details such as name or address etc.
But it is always advisable to use a Label control before the text box,
informing the user what is required in the text box.



51

In order to create a text box, DOUBLE CLICK  on the Text Box
control.  A rectangular box will appear with default text as Text1. In the
properties on the left column, text will be automatically highlighted and the
default value on the right column will be Text1. The user can erase and type
the required text which will automatically get displayed in the text box. The
screen will appear as follows when the user double clicks on the Text Box
control.

Fig 2.9

2.5.2  LABEL

The label control displays text.  Labels are often used for titles, prompts
and descriptions. The label control has two properties namely AutoSize and
WordWrap.   In order to create a LABEL, DOUBLE CLICK  on the Label
control.  A rectangular box will appear with default label as Label1. In the
properties on the left column caption will be automatically highlighted and
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the default value on the right column will be Label1. The user can erase and
type the required label which will automatically get displayed as the Label.
The screen  will look as given below when the user double clicks on the
LABEL control.

 

Fig 2.10

2.5.3 LIST BOX

List Box is used to display the list of available data. If the number of
items in the list is more, automatically a vertical scroll bar is added to the
List Box. From the list box, the user can select one or more items. To add
items to the list box control, Visual Basic provides the 'Add Item ' method.
An item can be removed from the list box control using 'Remove Item'
method.
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The icon for List Box is . The screen will appear as follows when

List Box is selected.

Fig. 2.11

2.5.4.  COMBO BOX

Combo Box is a combination of List Box and Text Box. This enables
the user either to select an item from the list or to key-in / enter a value from
the keyboard. This control contains multiple items but occupies less space
on the screen. This is an expandable list box control. The user can expand it
to make a selection and retract it after the selection is made. The icon for

combo box is  . When combo box is selected from the tool box the

screen will appear as follows.
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Fig 2.12

2.5.5. MESSAGE BOX

Message Box is used to display a message to the user during execution
of the application. After reading the message displayed, user can click OK
button to continue with the process.  This has different formatting options
and allows the user to decide the appearance and the style of the Dialog Box
in various ways. A sample Message Box and the coding is as follows;

Message Box

Fig 2.13
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Program Code to create the above Message Box is;

Fig 2.14

2.5.6. INPUT BOX

Input Box  enables the user to enter text or values and returns the
contents as per the controls. This gets data from the user by displaying a
dialog box with a text box on it.

   Input Box is the opposite of the message box. Message box has a
primary purpose of displaying data to the user whereas Input box is designed
to get data from the user. Sample input box requesting the user to enter any
digit between 1 to 9 is as follows,

Fig 2.15

Program Code to create the above Input Box is;
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Fig 2.16

2.6.  DATABASE ACCESS

Visual Basic helps the user to create, manipulate and process records
using databases. There are several tools available in Visual Basic for this
purpose. Some of the frequently used tools to connect databases using Visual
Basic are;

• DAO - Data Access Object

• Microsoft Jet Database Engine and

• Data Control interfaces

Visual Basic provides connectivity to THREE kinds of databases using
the Data Access Object. They are

• Visual Basic Databases

• External Databases like dBASE, FoxPro, Lotus

• Open Database Connectivity or ODBC

2.6.1. ADO CONNECTION WITH DATABASE

ADO stands for ActiveX Data Objects. The ADO technology supports
the following data controls;

• ADO Data Control

• ADO Data Combo Control

• ADO Data List Control

The main advantage of ADO is its capability to access many kinds of
data. ADO controls are not limited only to the traditional relational and
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non-relational database information. They can also access, through advanced
programming techniques, things like Internet Browsers, E-Mail Text and
Graphics.

USING ADO DATA CONTROL

Many applications access information that are available in databases.
Because of the variety of database systems, it would be difficult to implement
a separate mechanism for accessing each type of database.

The ADO Data Control is a graphical control that has the basic
navigation features built into it. Hence, the applications using ADO Data
Control requires very little extra programming.

2.6.2. LINKING CONTROLS TO THE ADO DATA CONTROL

The ADO Data Control present in the form can be connected to
the Access database.

Each of the textbox is selected and its Datasource property is
set. Selecting the value from the dropdown list box will do this easily.

DO IT NOW EXERCISES

Let us try a sample VB program to ADD TWO NUMBERS.

1) Switch on the Computer.

2) Select Start à Programs à Microsoft Visual Basic

3) New Project Dialog Box will appear on the Screen.

      Click “Open”.

4) Form Window will appear on the screen along with Tool Box and Properties window.

5) Double Click on the     Command button.

     Hyphenated rectangular box with default caption “Command1” will appear on the
screen.

6) Using mouse select “Caption” from the Properties Window with default value
“Command1”.

7) Type the Caption as “ADD”.
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8) Double Click on    Label button.

Hyphenated rectangular box with default caption “Label1” will appear on the screen.

9) Using the mouse select “Caption” from the Properties Window which  has got the
default value as “Label1”.

10) Type the Caption as “Enter First Number”.

11) Double Click on    Label button.

12) Hyphenated rectangular box with default caption “Label2” will appear on the screen.

13) Using the mouse select “Caption” from the Properties Window which has got the
default value as “Label2”.

14) Type the Caption as “Enter Second Number”.

15) Double Click on    Label button.

16) Hyphenated rectangular box with default caption “Label3” will appear on the screen.

17) Using the mouse select “Caption” from the Properties Window which has got the
default value as “Label3”.

18) Type the Caption as “Sum of Numbers”.

19) Double Click on  Text Box button.

20) Hyphenated rectangular box with default caption “Text1” will appear on the screen.

21) Using the mouse select “Text” from the Properties Window which has got the default
value as “Text1”.

22) Delete “Text1”.

23) Double Click on  Text Box button.

24) Hyphenated rectangular box with default caption “Text2” will appear on the screen.

25) Using the mouse select “Text” from the Properties Window which has got the default
value as “Text2”.

26) Delete “Text2”.

27) Double Click on  Text Box button.

28) Hyphenated rectangular box with default caption “Text3” will appear on the screen.

29) Using the mouse select “Text” from the Properties Window which has got the default
value as “Text3”.
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30) Delete “Text3”.
THE VISUAL BASIC SCREEN WILL APPEAR AS FOLLOWS WITH THE
PREVIOUS STEPS.

Fig 2.17

31) Double Click on the Command Button in the FORM with caption ADD.
The screen will appear as follows.

Fig 2.18
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32) Type the following Code.
Text3.Text = Val(Text1.Text) + Val(Text2.Text)

33) Select “Start” option from “Run” in the menu bar.

34) Using mouse pointer enter a value for “Enter First Number”.

35) Using mouse pointer enter a value for “Enter Second Number”.

36) Click ADD.

37) Result will be displayed.

38) The screen will appear as follows.

Fig 2.19

TRY THE FOLLOWING

1. Design a form and write the code to subtract two numbers.

2. Design a form and write the code to multiply three numbers.

3. Design a form and write the code to divide two numbers.

4. Design a form and write the code to use the computer as calculator.

5. Design a form and write the code to find the area of a square.

6. Design a form and write the code to find the area of a rectangle.

7. Design a form and write the code to find the area of a triangle.

8. Design a form and write the code to find the area of a circle.

9. Design a form and write the code to display the message “Happy New Year.”

10. Design a form and write the code to display the message “Happy New Year” with
your name.
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SELF EVALUATION

I. FILL IN THE BLANKS :

1. Visual Basic is the most suitable programming language for developing programs
or  applications with ______________.

2. The popularity of VB is because it is equipped with ________.

3. When we first start or select a file in Visual Basic the ___________ will appear.

4.  _______ is used to manage the components of application.

5. The toolbox is a collection of ________.

6. The Visual Basic ________ appears in the next line of Menu Bar.

7. VB has a total of ______ toolbars.

8. ________ contains toolbar buttons for some commonly used menu items for
debugging code.

9. ________ helps in  editing the Visual Basic Code.

10. ______  helps to adjust objects on forms.

11. _______ is the default toolbar which appears below the Menu Bar.

12. The components of  the user interface are placed on a screen which in turn is
called as _____.

13. The _____  can be maximized or minimized.

14. The ________  shows the preview of the Form Window’s location.

15. A _______ holds all the elements of an application the form window, the
components and the coding.

16. Whenever a standard EXE is created, a blank project named  ______ will be
automatically created.

17. A _____  consists of different controls  and menus.

18. Forms are stored with an extension _________

19. ___________ are used to create our own custom objects.

20.  Class Modules are stored with an extension _________.

21. _______ Modules contain procedures and declarations.

22. Standard  Modules are stored with an extension _________.
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23. _______ Files contain references to bitmaps, images and special   texts.

24. Resource  files are saved with an extension_______.

25. The user can place a lot of controls on the______.

26. The user can change the properties during ______ time.

27. An _______ is a collection of forms, controls and  codes.

28. VB project can be executed in _________ different ways.

29. In programming, one need to process different types of _______.

30. The range of data type Byte is ________.

31. The range of data type Date is _______.

32. Boolean data type can take the value as _______ or ________.

33. The _______ data type’s storage capacity is 12 bytes.

34. String concatenation operators are ______ and ______.

35. When the user wants to type an answer or reply to a prompt ______  is used.

36.  It is always advisable to use a _____ control before the text box.

37. The label control displays _______.

38. ______  are often used for titles, prompts and descriptions.

39. The ______ control has two properties namely AutoSize and WordWrap.

40. _______  is used to display the list of available data.

41. If the number of items in the list is more, automatically a __________ is added
to the List Box.

42. _______  is a combination of List Box and Text Control.

43. _________ Box is used to display a message.

44. ________ Box  prompts the user to enter text or values.

45. The ________ stands for ActiveX Data Objects.

46. Visual Basic helps the user to create, manipulate and process records using
__________.

47. Visual Basic provides connectivity to _______ kinds of databases using the
Data Access Object.
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II. ANSWER IN ONE OR TWO SENTENCES :

1. Mention the reason for the popularity of Visual Basic.

2. What is the use of New Project Window ?

3. Mention the names of  different types of Toolbars.

4. What is the use of Debugging Tool bar ?

5. What is the use of Editing Tool bar ?

6. What is the role of Windows in VB?

7. Mention the different types of Windows available in VB.

8. Write short notes on Form Window.

9. Write short notes on Form Layout Window.

10. Define : Project

11. What are the contents of a Project ?

12. What is the role of Standard Modules in a VB project ?

13. What are the contents of  Resource Files ?

14. Write short notes on Properties Window.

15. Mention the names of some of the properties in the Properties Window.

16. What is the role of Project Explorer Window ?

17. Define : Application

18. What is the use of data type DATE ?

19. Give example for string concatenation operators.

20. What is the use of Variant data type ?

21. Give examples for the operators used in VB.

22. Mention the order of hierarchy of VB operators.

23. What is the use of  Text Box ?

24. Mention the properties associated with label control.

25. What is the use of List Box ?

26. What is a Combo Box ?

27. What is the use of Combo Box ?
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28. What is Message Box ?

29. Mention the data controls available in ADO.

30.  Mention some of the frequently used tools to connect databases.

III. ANSWER IN DETAIL :

1. Write notes on VB - IDE windows.

2. Write short notes on Toolbox.

3. Write notes on Form Editor.

4. Write short notes on Standard Tool bar

5. Write a brief account on Form Modules.

6. Write a note on Class Modules.

7. Mention the different ways of running a VB project.

8. Mention the names of different data types available in VB.

9. Mention the operators available in VB.

10. Mention for what purpose label control is used with example.

11. Give an example for the use of Message Box.

12. What for Input Box is used ? Give example.

13. What are the advantages of ADO?

14. Write a brief account on ADO.

15. Mention the databases supported by VB.

_________
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3. IT APPLICATIONS

3.1. INTRODUCTION

The eighteenth century was the time of great mechanical systems
accompanying the Industrial Revolution.  The nineteenth century was
captured by steam engine. During the twentieth century, information
gathering, processing and distribution were the key technology. The
installation of worldwide telephone networks, launching of communication
satellites are other major developments in this century.

The computer industry is young compared to other industries. But it
has made a spectacular progress spreading its wings in almost all businesses
of today. It helps to collect and maintain information of any business as
Information is knowledge and knowledge is power.     

3.1.1. INFORMATION TECHNOLOGY

Information technology refers to all forms of technology applied to
processing, storing and transmitting information in electronic form. The
physical equipments used for this purpose include computers, communication
equipments and networks, fax machines, etc.

Information is a tangible or intangible entity that serves to reduce
uncertainty about some state or event.  Information Systems execute
organized procedures that process and / or communicate information. The
system usually processes these data in some way and presents the results to
users.

Information technology, however, extends far beyond the
computational capabilities of computers. Today, computers are used
extensively for data storage, computation and communication. Many
computers are connected together to form networks. Through a network,
individuals and organizations are linked together and these linkages help in
business. In the first era, computers were concerned with computation and
the second era is about communications.
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Information Communication Technology, particularly the Internet is
promoting all activities dependent on information. It offers new opportunities
to both consumers and producers of information in business transactions.

3.2. BUSINESS APPLICATIONS

Detailed and extensive records are needed in business, whether it is
commercial or administrative.  Elaborate details are required to process
business applications like sales details, marketing analysis, accounting, salary
details, personal management, industrial applications like inventory and stock,
etc. Because of the size and complexity of the data, computers have become
vital to manage them effectively.

In all the above applications, it is necessary to collect information at
periodical intervals, detect errors or repetitive information and create routine
reports on a weekly or monthly basis. Computers are largely employed as an
“aid to the management” in administering the business and commercial
applications for faster process and better results. Computers are employed
in the following business applications;

(1) Payroll

(2) Inventory Control

(3) Stock Statement

(4) Banks

(5) Reservation in Rail / Bus / Air

(6) Hospitals

(7) Insurance Companies

(8) Stock Markets

(9) Cost and Budget Applications

(10) Financial Accounting, etc.

3.2. IT AND BUSINESS
IT helps business in the following;

(i)   To design and structure the organization
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(ii) To increase efficiency and quality through automated production
processes.

(iii) To create tie-ups and partnership with support service providers.

(iv) To collect the information required for business through World
Wide Web.

(v) To adopt group decision support systems for workers who share
a common task or use common records.

(vi) To eliminate physical documents for routine transaction processing
and  substitute with electronic methods through networks

(vii) To help in controlling the organization and obtain results reports.

The benefits in a business, which properly utilizes Information
Technology, can be summarized as follows;

(i) Giving a competitive edge

(ii) Increasing revenues

(iii) Reducing costs

(iv) Improving profits

(v) Improving quality

(vi) Creating new opportunities

(vii) Improving the overall structure of the organization

One of the major trends in the recent years is Globalisation and IT
forms the basis of almost all International Businesses.

3.3. DATABASE PUBLISHING

Data are a set of isolated raw facts, figures, statistics, etc. A database
is an organized collection of data. Information is the result or product of
processing the data. The administration of database is popularly known as
DBMS. A DBMS allows the user to enter, store, manipulate and retrieve
information organized into databases.  DBMS provides interactive access
to data and provides easy way to print reports.

The data must be stored in direct-access devices. Database systems
are designed with a view to optimize the use of physical storage and
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processing time. Database systems are rapidly gaining popularity among
business users. Different Database models are available and some popular
models are

(a) Relational Database

(b) Hierarchical Database and

(c) Network Database.

RELATIONAL DATABASE MODEL  :  Relational Database is the
most popular model. This is based on two-dimensional table. Rows in the
table represent the records and columns represent the attributes of the entity.

HIERARCHICAL DATABASE MODEL :   This model relates
entities by superior / subordinate or parent/child relationship. It permits two
types of relationship namely one-to-one and one-to-many.

NETWORK DATABASE MODEL :   This model is similar to the
hierarchical model, except that an entity can have more than one parent. It
permits three types of relationship namely one-to-one, one-to-many and
many-to-many.

Database is popular due to the following factors :

(1) Existence of the same data in different places can be reduced.
(i.e.) duplication of data can be avoided.

(2) Inconsistency can be avoided.

(3) Data can be shared.

(4) Standards can be enforced.

(5) Security restriction can be applied.

(6) Integrity can be maintained.

Database system helps to prepare reports from the stored information.
This process of conversion of information into the required report finds its
application in all businesses. Collecting and maintaining data cannot fulfill
the business needs.  The summarized data in a report format helps to analyze
the success and failure of the business.  
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3.4. MIS- MANAGEMENT INFORMATION SYSTEM

MIS stands for Management Information System. This is an
integrated man-machine system that provides information to support the
various functions of managers in a business and helps in decision-making
process.

A business application that collects, maintains, correlates and selectively
displays information to assist human beings, particularly managers in a
business is called as Management Information System.

In a nutshell, MIS provides “INFORMATION ” to managers. There
is a big question on “information” i.e. WHAT INFORMATION DOES THE
MANAGERS NEED ?

The main objective of this system is to provide systematic or organized
informational support to the managers. MIS should develop the much needed
management information rather than their facts. It should provide relevant
information in a summarized format. At the same time, it should be flexible
and sensitive enough to cater to the relevant changes in technologies
pertaining to the business.

MIS includes files, hardware, software and operations research models.

The main features of MIS are;

i. It sub-serves managerial functions

ii. It collects information systematically and routinely

iii. It supports planning and control decisions of managers in a business.

3.5. IVRS - INTERACTIVE VOICE RESPONSE SYSTEM

IVRS is a software application that accepts a combination of voice
telephone input and touch-one key-pad selection and provides appropriate
responses.  These responses may be in the form of voice, call back, e-mail,
etc.

IVRS is a part of a larger application that includes database access.
An IVRS application provides pre-recorded voice responses suitably for
various situations. 

Common IVRS applications include;
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(i)  Bank and stock account balances and transfers

(ii) Surveys and polls

(iii) Call centre forwarding

(iv) Simple order entry transactions

(v)  Selective information lookup (movie schedules, etc.,)

This software allows the business to automate customer service
functions such as requesting a quote, routing calls, checking account balances,
faxing, etc.

Depending upon the business needs, the IVRS software may be used
and the benefits of IVRS software include;

(i) Reduce costs by relying less on human representatives

(ii) Integration with existing environment

(iii) Provides customer self-service

(iv) Reduces total cost of ownership

(v) Extensive reporting and customization of reports

(vi) Integration of other technologies to provide more features.

There are several IVRS software packages available. Depending on
the business requirements, suitable IVRS software can be selected by
implementing a trial version.

3.6. NETWORKS

In Information technology, computers and communications are
considered as the main components. Computers are used to generate
information. The generated information must be transmitted from one location
to another for greater use. This data communication is done through
networks.

A network is a series of points or nodes interconnected by
communication paths. Networks can interconnect with other networks and
contain sub-networks.  Computer Network is a set of interconnected
autonomous computers to communicate with each other. Two computers
are said to be interconnected if they are able to exchange information. Most
networks consist of more than two computers.
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3.6.1. TYPES OF NETWORK

Networks are divided into different kinds on the basis of their size. To
mention a few;

VAN – Value Added Network

SN – Switched Networks

LAN – Local Area Network

WAN – Wide Area Network

MAN – Metropolitan Area Network

3.6.2. LOCAL AREA NETWORK ( LAN )

In this type of network, computers located near each other, say within
a small area like a room, campus or an office are interconnected by means of
cables.

Thus, LAN is a group of computers and associated devices that share
a common communication line or wireless link and typically share the
resources of a single processor or server within a small area ( for example,
within an office building).

3.6.2 WAN - WIDE AREA NETWORK

In this type of network, computers in a wide geographical area are
interconnected. Earlier telephone cables were used to interconnect and now-
a-days, WAN networks use satellite technology.

A Wide Area Network is a geographically dispersed
telecommunications network. This may be privately owned or rented. The
term usually connotes the inclusion of public (shared user) networks.

An intermediate form of network in terms of geography is a
Metropolitan Area Network (MAN)
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3.6.3 NETWORK TOPOLOGIES

A network’s shape or geometrical arrangement of computers is known
as Network Topology. It represents the physical arrangement of systems,
communication devices and network cable.

The most common topology or general configuration of networks
include

               •            Bus Topology

               •            Star Topology

               •            Ring Topology

Bus Topology : A bus topology uses a single transmission medium
called a bus. A coaxial cable serves as the transmission medium. All computers
will be connected directly to this bus. It requires special end connectors
(terminators) to both ends of the bus. Data can flow in either direction of the
bus.

 

Fig.3.1

Star Topology : In this topology, all computers or nodes are connected
to a central computer. The central computer transmits data to all the
connected nodes.  Direct connections between computers do not exist in
this star topology.

 

 

 

 

Fig. 3.2
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Ring Topology : In a ring topology, the network has no end
connections. The network forms a continuous ring without any break in the
path. Data flows in only one direction around the ring.

Fig. 3.3

3.7 SECURITY ON NETWORKS

Security on networks is the protection of networks and their services
from unauthorized modification, destruction or disclosure.

Network Security refers to the proper safeguarding of everything
associated with a network including data, media and equipment.

Network Security Systems are security procedures and controls that
protect a network from;

(i) Unauthorized access, modification and information disclosure

(ii) Physical impairment or destruction. 

The security system makes certain that only people who are authorized
can use the network resources in accordance with the prescribed policy of
the business. Network Security provides businesses with the tools necessary
to keep their networks safely and to run them smoothly.  This is an effort to
create a secure platform so that agents or users can perform only the actions
that are allowed.
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Each network security rule consists of conditions for network traffic
and of actions, which are taken when the conditions are met.

3.8. NEW GENERATION DEVICES

The computer industry is the fastest growing industry in the world.
There are varieties of new devices coming everyday. To mention a few, new
devices are coming in the following fields.

• Information Networks

• Communications

• Business and Government enterprises

• Financial Services

• Publishing

• Entertainment

• Hospitals

• Artificial Intelligence

• Parallel Processing

• Biochips

• Voice Recognition

• Robots

3.9. NETWORK PROTOCOLS

A protocol is the formal rule and convention governing the exchange
of information between computers, defined to provide reliable and efficient
transfer of information in the networks. There are many standard protocols
from which the programmer can choose. The protocols can be implemented
either in hardware or in software.  Some of the commonly used network
protocols are Simple Mail Transfer Protocol (SMTP), Hyper Text
Transfer Protocol (HTTP), Internet Protocol (IP), Wireless Application
Protocol (WAP), etc.
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3.9.1.  WAP-WIRELESS APPLICATION PROTOCOL

Two of the technical developments that have a direct effect on the
lives of millions in the recent years are the Internet and Mobile Communication
with the use of mobile phones. The Internet has provided its users the
possibility to access a vast amount of information irrespective of their location.
Mobility is the ability to access the information and services at any time,
anyhow and anywhere.

To enhance the overall size of business opportunity, manufacturers
decided to join forces on technology and extended an invitation to the wireless
industry to develop a common standard for wireless data applications. Thus
WAP forum was born. WAP is a protocol suite created for mobile devices to
give their users a richer data and enable access to the Internet.

The Wireless Application Protocol (WAP) forum builds a specification
that works across a variety of wide-area. The goal is to bring Internet content
and telephonic services to digital cellular phones and other wireless terminals.

3.9.2. WAP BASED DEVICES

Wireless Application Protocol based devices make it possible to access
Wireless Markup Language (WML) based services with mobile browsers. 
It is possible to access the already existing Information with WAP devices.
The first WAP-compliant devices were introduced to the market in the year
1999. The WAP services currently available are not generic but they have
been tailored to specific WAP devices.

Symbian has classified future mobile devices into three categories;
Communicators, Smart phones and Feature phones. The classification is
based on input methods and display size. WAP devices will include all of
Symbian’s categories.

The selection of WAP devices ranges from mobile phones to palmtop
computers. Since these WAP devices are very wide, the services have to
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take into account the capabilities of the mobile clients. The WAP specification
defines the User Agent Profile, which will be used to transmit information
about the client. It includes device hardware and software characteristics as
well as application and user preferences.

3.10. G3

G3 in computers means the “Next Generation Wireless Networks”.
As the number of portable computing and communication devices grows,
so does the demand to connect them to the outside world. Even the very
first portable telephones had the ability to connect to other telephones. The
first portable computers did not have this capability.  But soon, modems
filled this necessity.

To go on-line, these computers had to be plugged into a telephone
wall socket.  To achieve true mobility, portable computers need to use radio
or infrared signals for communication. In this manner, users can read and
send email. A system of portable computers that communicate by radio can
be regarded as a wireless LAN.

Wireless LANs are generally categorized according to the transmission
technique that is used.

The Wireless LAN products fall into the following categories;

• Infrared ( IR ) LANs

• Spread Spectrum LANs

• Narrowband Microwave

3.11.  CDMA - CODE DIVISION MULTIPLE ACCESS

CDMA, a cellular technology originally known as IS-95, competes
with GSM technology for dominance in the cellular world.  Developed
originally by Qualcomm and enhanced by Ericsson, CDMA is characterized
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by high capacity and small cell radius, employing spread-spectrum technology
and a special coding scheme.

CDMA was adopted by the Telecommunication Industry Association
(TIA) in 1993. There are now different variations, but the original CDMA is
now known as cdmaOne. We now have cdma2000 and its variants like IX
EV, IX EV-DO and MC 3X. 

Over 35 countries have either commercial or trial activity ongoing.
There are already 43 Wireless Local Loop (WLL) systems in 22 countries
using cdmaOne technology.

Enhancing today’s data capabilities is the IXRTT CDMA standard.
This is the next evolutionary step for cdmaOne.

3.12. GPS - GLOBAL POSITIONING SYSTEM

A System of satellites, computers and receivers that is able to determine
the latitude and longitude of a receiver on Earth by calculating the time
difference for signals from different satellites to reach the receiver is called
as Global Positioning System.

GPS involves Satellite Tracking. This is a satellite navigation system
used for determining one’s precise location and providing highly accurate
time reference almost anywhere on Earth or in Earth’s orbit.  It uses an
intermediate circular orbit (ICO) satellite constellation of atleast 24
satellites.

The GPS was designed by and is controlled by the United States
Department of Defence and can be used by anyone, free of charge.

3.12.1. GPS SEGMENTS

The GPS is divided into three segments;  Space, Control and User. 

The space segment comprises the GPS satellite constellation. The
control segment comprises of ground stations around the world that are
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responsible for monitoring the flight paths of the GPS satellites. The user
segment consists of GPS receivers used for both military and civilian
applications. GPS receivers convert signals into position, velocity and time
estimates. Four satellites are required to compute the four dimensions of
X,Y, Z  ( for position ) and Time.

GPS receivers are used for navigation, positioning, time dissemination
and in other research fields.

3.13.  TYPES OF PROCESSING

Data Processing may take place within the database system, server, or
client. It includes the following steps;

(i)   Data coding

(ii)  Data input

(iii) Data editing and

(iv) Data manipulation

Data can be processed in different ways using computers, which vary
from the type of devices used, the volume of information and the nature of
the work. Processing can be broadly divided into the following types:

• Batch processing

• On-Line processing, etc.

3.13.1. BATCH PROCESSING

This type of processing involves performing a particular operation
automatically on a group of files all at once rather than manually opening, 
editing and saving one file at a time.  (i.e.) Processing a group of transactions
at one time. 

Transactions are collected and processed against the master files
(updated) at the end of the day or some other time period. This is the
sequential execution of a series of programs (jobs) on a computer.
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In many companies, the batch jobs would be scheduled on a timetable,
like ‘end of day’, ‘end of month’, etc. For example, the electronic transactions
for telephone calls are stored in the computer until the month end and then
processed in batch.

3.13.2. ON-LINE PROCESSING :

On-Line transaction processing also called as Transaction processing
is a daily work. It means that the database is updated as soon as a transaction
is received. For example, computerized reservation system, a sales order
depleting inventory, a stock sale updating the closing balance, etc.. uses on-
line processing.

SELF EVALUATION

I.  FILL IN THE BLANKS :

 1. ________  are largely employed as an aid to the management.

 2. ________  is an organized collection of information.

 3. ________ stands for Management information system.

 4. ________ is the ability to access the information and services any time, anyhow,
anywhere.

 5. The ________  has provided its users the possibility to access a vast amount of
information irrespective of its location.

  6. By ________ in computers we mean the “Next Generation Wireless Networks”

II. ANSWER IN ONE OR TWO SENTENCES:

 1. Mention some of the business applications of IT.

 2. What are the different models of Database?

  3. What is the aim of MIS ?

  4. What is LAN ?

  5. What is WAN ?

  6. What is Network Security? 
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III. ANSWER IN DETAIL:

 1. What is Topology ? Discuss the different types of topologies.

 2. Explain Interactive Voice Response System.

 3. Explain Wireless Application Protocol.

 4. Explain Code Division Multiple Access.

 5. What is GPS ? Explain.

 6. Mention the different types of data processing.

___________
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IMPORTANT THINGS TO REMEMBER

Navigate the datasheet using the Keyboard

Key Action

Next field Tab

Previous field Shift + Tab

First field of current record Home

Last field of current record End

Next record Down arrow

Previous record Up arrow

First field of first record Ctrl + Home

Last field of last record Ctrl + End

Scroll up one page Pg Up

Scroll down on page Pg Dn

Goto record number box F5

ABBREVIATIONS LINKED WITH MS-ACCESS

DBMS : Data Base Management System

DBA : Data Base Administrator

DBF : Data Base File

DDE : Dynamic Data Exchange
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DML : Data Manipulation Language

DDL : Data Definition Language

SQL : Structured Query Language

OLE : Object Linking and Embedding

ODBC : Open Data Base Connectivity

RDBMS : Relational Data Base Management System

STANDARD CONTROLS

Pointer control : To move or resize a control.

Picture box : To display graphic image

Label control : To identify controls.

Text box : To display the text.

Frame : To group other controls.

Command button : To perform actions.

Checkbox : Select any number of check boxes at the

same time.

Option button : To communicate with his program by

clicking, typing or manipulating the

object.
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List Box : Display a list of items.

Combo box : Combines the features of a text box and

a list box.

Horizontal/Vertical scrollbars : Scrolling either horizontally or vertically.

Timer control : It respond to the passage of time,

program them to take actions at regular

intervals.

Drive List box : To select a valid disk drive at run time.

Directory List box : To display directories and paths at run

time.

File List box : To display files contained in the directory

specify by  the path property at run time.

Shape : Graphical control displayed as a

rectangle, oval and square.

Line control : To draw lines on the form.

Image : To display the images.

Data control : It provides access to data store in

databases.

OLE Control : It is a window you can place on your form

to host documents from other

applications.
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Default properties of common Control in VB

CONTROL VALUE

Check box Value

Option button Value

Combo box Text

Label Caption

Text box Text

Image Picture

Picture box Picture

Horizontal scrollbar Value

Directory List box Path

Drive List box Drive

File List box File Name

_________


